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INTRODUCTION 
There is one spreadsheet, analysistoolv*.xls designed for users of Microsoft Excel 
2000 or Microsoft Excel 97. 

 

LAUNCHING THE SPREADSHEET 
To make the analysis tool work, save a copy to your computer. 
 
Launch the spreadsheet and select Enable Macros. 
 
If the Enter Questionnaire Scores worksheet is empty, you should verify that 
your security settings will allow macros to be run. To do this you should go to the 
Tools menu and select Macro. Then select Security. Ensure that security is set to 
either ‘Medium’ or ‘Low’ (‘Medium’ is the recommended option). You can restore 
security settings when you have finished using the application. You should close and 
reopen the application if it is already open. We recommend that you restore the 
original setting as soon as you have finished using the application. (Note: these 
instructions on security settings do not apply to users of Excel 97). 
 
At the bottom of the first screen you will see a series of tabs (see Figure 1 below). 
Clicking on the tabs allows you to move to different worksheets. Please do not 
change the names of any of the worksheets as this will affect the operation of the 
analysis tool. 

 
 Figure 1: HSE Analysis Tool first screen  
 
CHECKING FOR OLD OR UNWANTED RECORDS  
Before you begin to enter your questionnaire scores for the first time, it is advisable 
to check that the spreadsheet does not contain any old or unwanted records (see  
DELETING ONE OR MORE RECORDS below).   
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CATEGORISING EMPLOYEES INTO DIFFERENT GROUPS  
You may wish to identify the main issues affecting different groups of employees. 
The Categories tab allows you to set up the analysis tool to enter results for 
different  groups of staff. You can use this to set up your own choice of group 
identifiers in up to four categories.  In the example in Figure 2 below, the coordinator, 
or person setting up the categories, has chosen to enter results using the categories 
of location, grade of staff, sex and age. If you wish to use the Categories facility, 
you must do this before entering any results.  

 

 Figure 2: HSE Analysis Tool Categories screen 
 
ENTERING YOUR QUESTIONNAIRE SCORES  
Select the Enter Questionnaire Scores worksheet from the tabs at the bottom of 
the screen.  The first page of the Scores Entry input form is shown in Figure 3 
below.  
 
If the questionnaire results you are about to enter have been categorised into groups, 
use the drop down menus to indicate the group(s) to which the results you are 
entering belong.  
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 Figure 3: Scores Entry input form – categories drop down menus  
 
Now click on the > button to continue with the rest of the questionnaire.  The 35 
questions are distributed over 5 pages.  For each question, click on the option button 
that corresponds to the answer in the questionnaire. 
 

 

Figure 4:  Scores Entry input form – questions 1-7 
When you have entered the replies to the first five questions, click the > button to 
move to questions 8 to 14. 
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Figure 4:  Scores Entry input form – questions 8-14 

You can use the > and < buttons to step from one screen to the next. Or you can go 
directly to a page by using the Select Questions buttons. 

The Save New Record button will be activated when you open the last page 
(Figure 5 below). Click it when you have finished entering the replies for a 
questionnaire. You will be prompted to confirm that you wish to save the record. If 
you select Yes, a message box will say Record Added showing that the record 
has been added successfully.  

 

 Figure 5:  Scores Entry input form – last page 
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Now click the New Record button. This takes you directly to the first page of the 
Scores Entry input form, resets the questions to No Answer and increments the 
New Record Number by 1. You can then use the drop down menus to make any 
changes required in any of the four Categories, and start entering your results for 
the next questionnaire. 

The New Record Number box on the Enter Questionnaire Scores worksheet 
allows you to specify the questionnaire number for a new record. The record number 
is stored in the Raw Data worksheet. The numbers normally start at 1 and are 
incremented automatically. However, you can change the number in the box if you 
want to, and this number is the one that will be saved.  

You may realize that you have entered the wrong answers for a questionnaire. The 
Delete Last Record button will remove the last record that you have saved. 

 
OBTAINING A SUMMARY OF YOUR RESULTS 
When you want to see a summary of the results you have entered, select the 
Summary of Results worksheet (Figure 6 below) from the tabs at the bottom of 
the screen (users of Excel 97 will need to click the Close button before they can exit 
the Enter Questionnaire Scores worksheet). 

The Your Results column gives the average value for the responses to each of the 
stressors covered in the 35 questions. The Suggested Interim Target column 
gives the target score that we suggest would be a reasonable target for you to aim 
for next time (for example, in 6 months to a year’s time). The way this is calculated is 
described in Appendix A. The Suggested Longer Term Target is the value 
achieved by the top 20% of workers in a national survey of working conditions in 
Britain (see Appendix A for more details). 

 

 Figure 6: Summary of Results worksheet 
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INDIVIDUAL QUESTION RESULTS 
The Question by Question worksheet (Figure 7 below) shows you the average 
score for each question. The colour coding gives an indication of how your 
performance for that question relates to the responses given by employees taking 
part in a national survey (see Appendix A; please note in particular the caveats 
concerning use and interpretation of results). 

 
Figure 7: Question by Question worksheet – results for individual 
questions  
 
SAVING RESULTS 
After you have finished entering all your results, save them by selecting Save from 
the File menu.  You may want to save the results under a name such as Whole 
organisation or another name that is familiar to you. Do this by selecting Save As 
from the File menu and change the file name accordingly. To prevent you 
accidentally overwriting or deleting some of your results it is advisable to copy this file 
and save it as a working file called Results analysis file or some such title.  

 
EXAMINING RESULTS FOR DIFFERENT CATEGORIES OF STAFF 
Open the Results analysis file and select the Raw Data worksheet (Figure 8 
below). Click on the small button to the right of the category heading to use the auto 
filter function. In the example below, the user is choosing to filter on ‘Management’. 
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 Figure 8: Raw Data worksheet 
 
You can now select the Summary of Results or the Question by Question 
worksheets to examine the results for the group you have selected.  In the example 
in Figure 9 below, the Category Filter message above the Key indicates that the 
user has chosen to examine the results for London-based, male, administrative staff. 
 

  
 Figure 9: Summary of Results for group selected  
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SAVING RESULTS FOR DIFFERENT GROUPS OF STAFF 
You may wish to keep all your results together in the one Results analysis file, or 
you may wish to split data to create separate files for different groups of staff.  
An easy way to do this is to start by using the filter function as described above to 
filter the data for the first group (e.g. ‘Management’). Then select Save As from the 
File menu and save as a new file.  You can now use the Extract button (to the left 
of the Import button in the Raw Data worksheet) to delete all the other rows of data 
from this file.  Warning!  Please note that this process is irreversible, it is important to 
save the original spreadsheet first under a different name, otherwise you will lose 
data.  (Note: the Extract function may not function correctly in Excel 97). 
 
 
DELETING ONE OR MORE RECORDS 
The Enter Questionnaire Scores screens allow you to delete the last record in 
the Raw Data worksheet.   

In addition to this, you can delete a record or a series of records in the following way. 
Select the Raw Data worksheet from the tabs at the bottom of the screen and then 
select the records you wish to delete by clicking and dragging on the Row heading 
numbers (the numbers in the extreme left hand column) of the records you wish to 
delete.  This will highlight the rows you wish to delete (see Figure 10 below).  Then 
select Delete from the Edit menu to delete the rows you have selected.  

 

Figure 10:  Highlighting Row Heading numbers for deleting 
 
If the records that you have deleted are the last records in the Raw Data worksheet, 
then the New Record Number will be updated on the Enter Questionnaire 
Scores worksheet.   

If the records you have deleted come from earlier in the series, you can use Excel’s 
Series Fill feature to revise the record numbers found in the Record Number 
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Column (AJ) of the Raw Data worksheet. In Excel, the Series Fill feature can be 
accessed by selecting the Edit menu, then selecting Fill >, Series. 
 
IMPORTING DATA 
You can import and collate raw data from other copies of the HSE Analysis Tool.  

To do this, first collect all the source files you wish to import data from into one folder. 
Put the target file (the one you wish to import data into) in a separate folder.  Ensure 
that all other workbooks are closed before proceeding   

Go to the Raw Data worksheet and find the Import button (to the right of the final 
columns of data).  Click on the button and select the folder that contains the .xls files 
you wish to process. When you click OK, each .xls file will be opened and any raw 
data contained in it added to the Raw Data worksheet of the target file. 

The success of processing depends on matching column headings (e.g. ‘Question 
35’) between source and target Raw Data sheets.  

Warning!  Depending on how many .xls files are being processed and the size of the 
files, importing raw data may be a lengthy operation.  

 

SCREEN LAYOUT AND TITLES 
Please do not change the layout on any of the screens as this may affect the 
operation of the Analysis Tool.  In the Summary of Results and Question by 
Question worksheets, the graphs are dependent on data that appears in fixed 
locations on the worksheet and if, for example, you insert a line for a title then the 
numbers will be in the wrong places. 

If you want to give a title to the spreadsheet, select Page Setup from the File 
menu, select Header/Footer from the tabs at the top of the dialog box and then 
Custom Header, and type your header/title in there.  It will show up in Print 
Preview and on the printout.    

 

TECHNICAL APPENDICES 
Appendix A contains a brief explanation of the approach taken to the calculation of 
current performance and targets. Appendix B contains more detailed technical 
information on the basis for these calculations.     
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APPENDIX A 
CALCULATION OF CURRENT PERFORMANCE AND TARGETS  
 
‘SUMMARY OF RESULTS’ SCREEN 
Each of the 35 questions in the HSE Indicator Tool relates to one of the seven 
stressors, which, in turn, relate to the respective Management Standards (Demands, 
Control, Managerial Support, Peer Support, Relationships, Role and change).  The 
items are based on the best available evidence linking work design to health 
outcomes.  

The scores provided by the HSE Indicator Tool are based on employee responses to 
the questionnaire. They indicate how you are performing against each of the 
Management Standards. The scores range from 1 to 5.  A lower score indicates poor 
performance, or a potential problem area.  See HSE Indicator Tool User Manual  for 
information on use of the HSE Indicator Tool and interpretation of results.   

The Your Results column on the Summary of Results worksheet gives the 
average score for your responses to the questions that relate to each of the 
stressors.   

The colour coding allows you to assess how you are currently performing when 
compared with the top 20%, average and bottom 20% of the scores of employees 
responding to the same questions as part of a nationwide survey of psychosocial 
working conditions1.   

Suggested Interim Target 
The Suggested Interim Target column gives the target score that we suggest that 
you aim for in the short term (for example, the next 6 to 12 months) when you next 
measure your performance using the Indicator Tool. It is calculated using a ‘rule of 
thumb’ formula that relates your scores to the scores from the national survey. The 
formula suggests that proportionately larger improvement ‘steps’ are required the 
lower your initial scores (compared with the national survey scores) and 
proportionately smaller improvement ‘steps’ are required the higher your initial 
scores.  

Suggested Longer Term Target 
 The Suggested Longer Term Target represents the score for each of the 
stressors recorded by the top 20% of the national survey respondents. If you have 
reached this target score, we suggest that you continue to set your own targets for 
continuous improvement. 

 

‘QUESTION BY QUESTION’ SCREEN  

In addition to the information on the Summary of Results screen, the Question 
by Question screen allows you to obtain a more detailed picture of how the 
average scores of those responding to each question in the Indicator Tool compare 
with the average responses of the national survey respondents to the respective 
questions. It is suggested that this may prove helpful as a prompt to discussions 

                                                 
1 Health and Safety Executive (2004).  Psychosocial Working Conditions in Great Britain in 2004. This was a 
nationally representative  household survey of nearly 2000 current workers  conducted in March and April of 2004.  
The survey included the 35 question items representing the 6 Stress Management Standards areas. The full survey 
report is available on the HSE website at www.hse.gov.uk/statistics/causdis/pwc2004.pdf. 
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within focus groups but should not be interpreted as a definitive assessment of your 
performance. As suggested at ‘Step 3’ of the Stress Management Standards Website 
(‘Evaluate the risks and take action’), we recommend that you confirm all your survey 
results with your employees. This is particularly important when you are considering 
responses to individual questions. The comparisons of such responses with the 
national survey results should be interpreted as ‘suggestive’ or as a ‘prompt for 
discussion’ only.  
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APPENDIX B 
TECHNICAL INFORMATION AND PROCEDURES USED IN THE 
CALCULATION OF CURRENT PERFORMANCE AND TARGETS 
 

‘SUMMARY OF RESULTS’ WORKSHEET 
Table 1 contains data from the HSE survey Psychosocial Working Conditions in 
Great Britain 2004.  Table 1 shows the scores by cumulative percentiles of the score 
distributions for Demands, Control, Managerial Support, Peer Support, Relationships, 
Role and Change. (Please note that the order of these factors differs from the order 
given in Table 5 of the above survey report, in that Relationships appears before 
Role in Table 1).  

Your Results 
Table 2 shows the rules governing the colour coding cut-offs used in presenting the 
results in the Your Results column of the Summary of Results worksheet. 
These rules are derived from the data in Table 1. 

Note: 
• The survey results for the Role stress factor were very positively skewed (a 

large number of people scored 5 on the questions relating to Role). One 
consequence of this is that an organisation may achieve what appears to be a 
fairly high score on Role (e.g. 4.2) and yet find that they fall below the 20th 
percentile for that factor. 

 
Suggested Interim Target 
The procedure for working out the Suggested Interim Target for any given 
stressor is a pragmatic ‘rule of thumb’ procedure.  The procedure is described below. 

• The percentiles, from 5 to 80, at intervals of 5, and their associated values are 
stored in an array – these are derived from the data in Table 1. 

• The average score for the results entered to date (the figure in the Your 
Results column of the Summary of Results worksheet) is compared with 
the percentile values and the nearest value is selected (the highest value is 
selected in the case of ties). 

• The percentile associated with that value is subtracted from 100, the 
difference divided by 5; 

• The value obtained is added to the original percentile: that value is then 
rounded to the nearest 5; 

• The value associated with the resulting percentile is the Suggested Interim 
Target. 

 
Note: 

• The procedure ensures that scores that fall below the 20th percentile are 
always set a Suggested Interim Target at least equivalent to the 25th 
percentile score. 

• If an organisation scores at or above the 80th percentile on one of the stress 
factors, the procedure returns a message suggesting that they set their own 
interim and longer-term targets for continuous improvement. 
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Suggested Longer Term Target 
The Suggested Longer Term Target scores are derived from the 80th percentile 
figures in Table 1. 
 

‘QUESTION BY QUESTION’ WORKSHEET 
Table 3 shows the scores by cumulative percentiles of the score distributions for 
each of the individual questions grouped together under the factors Demands, 
Control, Managerial Support, Peer Support, Relationships, Role and Change.  This 
data is taken from the HSE survey Psychosocial Working Conditions in Great Britain 
2004.   

Table 4 shows the rules governing the colour coding cut-offs used in presenting the 
results in the Question by Question worksheet. These rules are derived from the 
data in Table 3. 

 
Note: 

• Please note the caveats in Appendix 1 on use and interpretation of the results 
for individual questions. 

• For many of the questions (including all of the Role questions and most of the 
Peer Support and Relationships questions) it was not possible to set cut-offs 
for the 50th-80th percentile range.  

• Question 21 I am subject to bullying at work is treated differently to the other 
questions, in that: 

o  anything less than 5 triggers a red colour coding; 
o  if any members of staff score 1, 2 or 3 on this question, the worksheet 

returns a message highlighted in red to the effect that  “* x (number) of 
your staff report that they are always, often or sometimes bullied.” 

This is in response to comments received during the Management Standards 
Pilots and in the course of consultations with various stakeholders.  Many 
people considered that any level of bullying was unacceptable and should be 
highlighted as an issue that might warrant further exploration, for example, 
during focus groups.  
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Table 1.  Psychosocial Working Conditions in Great Britain 2004 Report - Percentile Figures for Each Standard  
 

Percentiles                   

1  5 10                   15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 99

Demands 1.397
095 

2.125              2.5 2.75 2.875 3 3.125 3.25 3.375 3.5 3.5 3.625 3.75 3.875 4 4.125 4.25 4.375 4.5 4.75 5

Control 1.254
992 

1.8333
33 

2.1666
67 

2.3333
33 

2.6666
67 

2.8333
33 

3    3.1666
67 

3.1666
67 

3.3333
33 

3.5 3.6666
67 

3.8333
33 

3.8333
33 

4 4.1666
67 

4.3333
33 

4.5 4.6666
67 

4.8333
33 

5 

Management 
Support 

1.4                    2 2.4 2.75 3 3 3.2361
81 

3.4 3.6 3.6 3.8 4 4 4.2 4.2 4.4 4.6 4.6 4.8 5 5

Peer Support 1.75 2.5                  2.75 3.25 3.3333
33 

3.5 3.75 3.75 4 4 4 4.25 4.25 4.25 4.5 4.5 4.75 4.75 5 5 5

Relationships 2 3  3.25 3.5 3.75 3.75 4 4 4 4.25 4.25 4.25 4.2642
14

4.5 4.5 4.5 4.75 4.75 5 5 5 

Role 3.2 3.8    4 4.2 4.4 4.6 4.6 4.8 4.8 5 5 5 5 5 5 5 5 5 5 5 5

Change 1 1.6666
67 

2 2.3333
33

2.6666
67

2.6666
67

3 3 3.3333
33

3.3333
33

3.6666
67

3.6666
67 

3.6666
67

4 4 4 4 4.3333
33

4.6666
67

4.6666
67

5 

  
 
 
Table 2:  ‘Summary of Results’ Worksheet - Rules Governing Colour Coding Cut-offs for Each Standard 

 
Factor Red   Yellow Aqua Green 

 < 20th percentile >= 20th & < 50th 
percentile 

>= 50th & < 80th 
percentile 

>= 80th percentile 

Demands < 2.875 >= 2.875 & < 3.5 >= 3.5 & < 4.25 >= 4.25 

Control < 2.666667 >= 2.666667 & < 3.5 >= 3.5 & < 4.333333 >= 4. 333333 
Managers’ support  < 3 >= 3 & < 3.8 >= 3.8 & < 4.6 >= 4. 6 
Peer support < 3.333333 >= 3.333333 & < 4 >= 4 & < 4.75 >= 4. 75 
Relationship  < 3.75 >= 3.75 & < 4.25 >= 4.25 & < 4.75 >= 4.75 
Role  < 4.4 >= 4.4 & <5 No aqua =  5 
Change < 2.666667 >= 2.666667 & < 3.666667 >= 3.666667 & < 4 >= 4 
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Table 3: Percentile Figures for Each Question – Grouped by Standard 
  Percentiles 

 Demands                      1 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 99

3 Different groups at work demand things from me 
that are hard to combine 

1                     2 2 2 3 3 3 3 3 3 4 4 4 4 4 4 5 5 5 5 5

6 I have unachievable deadlines 1                     2 2 3 3 3 3 3 3 4 4 4 4 4 5 5 5 5 5 5 5
9 I have to work very intensively 1                     1 1 1 2 2 2 2 2 2 3 3 3 3 3 3 3 3 4 5 5

12 I have to neglect some tasks because I have too 
much to do 

1                     1 2 2 2.09 3 3 3 3 3 3 3 3 4 4 4 4 4 5 5 5

16 I am unable to take sufficient breaks 1                     2 2 3 3 3 3 4 4 4 4 4 4 5 5 5 5 5 5 5 5
18 I am pressured to work long hours 1                     1 2 2 2 3 3 3 3 3 4 4 4 4.7 5 5 5 5 5 5 5
20 I have to work very fast 1                     1 1 2 2 2 2 3 3 3 3 3 3 3 3 3 4 4 5 5 5
22 I have unrealistic time pressures 1                     2 2 2 3 3 3 3 3 3 4 4 4 4 4 4 5 5 5 5 5

 Control 1                     5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 99

2 I can decide when to take a break 1                     1 1 2 3 3 3 4 4 4 5 5 5 5 5 5 5 5 5 5 5
10 I have a say in my own work speed 1                     2 2 3 3 3 3 3 3.08 4 4 4 4 4 5 5 5 5 5 5 5
15 I have a choice in deciding how I do my work 1                     1 1 1 2 2 3 3 3 3 3 3 4 4 4 4 5 5 5 5 5
19 I have a choice in deciding what I do at work 1                     2 3 3 3 3 3 4 4 4 4 4 4 4 5 5 5 5 5 5 5
25 I have some say over the way I work 1                     2 3 3 4 4 4 4 4 4 4 4 4 5 5 5 5 5 5 5 5
30 My working time can be flexible 1                     1 1 2 2 2 3 4 4 4 4 4 4 4 5 5 5 5 5 5 5

 Managers’ Support 1                     5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 99

8 I am given supportive feedback on the work I do 1                     1 2 2 2 3 3 3 3 3 3 4 4 4 4 4 5 5 5 5 5
23 I can rely on my line manager to help me out with 

a work problem 
1                     1 2 2 2 3 3 3 3 4 4 4 4 4 5 5 5 5 5 5 5

29 I can talk to my line manager about something 
that has upset or annoyed me about work 

1                     2 3 3 3 4 4 4 4 4 4 4 5 5 5 5 5 5 5 5 5

33 I am supported through emotionally demanding 
work 

1                     2 2 3 3 3 3 3 4 4 4 4 4 4 4 4 5 5 5 5 5

35 My line manager encourages me at work 1                     2 2 2 3 3 3 4 4 4 4 4 4 4 5 5 5 5 5 5 5
 Peer Support 1                     5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 99

7 If work gets difficult, my colleagues will help me 1 1 2 3 3 3 3 3 4 4 4 4 4 4 5 5 5 5 5 5 5 
24 I get help and support I need from colleagues 1 2 3 3 4 4 4 4 4 4 4 4 4 4 5 5 5 5 5 5 5 
27 I receive the respect at work I deserve from my 

colleagues 
1                     2 3 3 4 4 4 4 4 4 4 4 4 4 5 5 5 5 5 5 5

31 My colleagues are willing to listen to my work-
related problems 

2                     2 3 3 4 4 4 4 4 4 4 4 4 4 5 5 5 5 5 5 5

 Relationships                      1 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 99

5 I am subject to personal harassment in the form 
of unkind words or behaviour 

2                     3 3 4 4 4 4 4 5 5 5 5 5 5 5 5 5 5 5 5 5

14 There is friction or anger between colleagues                      1.2999 2 2 3 3 3 3 3 3 3 3 4 4 4 4 4 4 5 5 5 5
21 I am subject to bullying at work 2                     4 4 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5
34 Relationships at work are strained                      1 2 2 2 2.0926 3 3 4 4 4 4 4 4 4 4 4 4.9074 5 5 5 5

 Role 1                     5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 99

1 I am clear what is expected of me at work                      3 4 4 4 4 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5
4 I know how to go about getting my job done 3 4 4 4 4 4.25 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 

11 I am clear what my duties and responsibilities are 3                     4 4 4 4 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5
13 I am clear about the goals and objectives for my 

department 
2                     3 4 4 4 4 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5

17 I understand how my work fits into the overall aim 
of the organisation 

2                     3 4 4 4 4 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5

 Change 1                     5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 99

26 I have sufficient opportunities to question 
managers about change at work 

1                     1 2 2 2 3 3 4 4 4 4 4 4 4 4 4 5 5 5 5 5

28 Staff are always consulted about change at work                      1 1 2 2 2 2 2 3 3 3 4 4 4 4 4 4 4 4 5 5 5
32 When changes are made at work, I am clear how 

they will work out in practice 
1                     2 2 2 2 3 3 3 3 3 4 4 4 4 4 4 4 4 5 5 5
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Table 4:  Question by Question Worksheet - Rules Governing Colour Coding Cut-offs for Each Question 
 
 

 
 Red 

 < 20th Percentile  
Yellow 

>= 20th & < 50th Percentile 
Aqua 

>= 50th & < 80th Percentile 
Green 

>= 80th Percentile 
Comments 

 Demands      
3 Different groups at work demand things from me 

that are hard to combine 
< 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95  

6 I have unachievable deadlines < 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95  
9 I have to work very intensively < 2 >=  2 & < 3 None >= 3 Not possible to set cut-offs for the 50th-80th percentile range 

12 I have to neglect some tasks because I have too 
much to do 

< 2.09 >= 2.09 & < 3 >= 3 & < 4 >= 4 Approx. 

16 I am unable to take sufficient breaks < 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95  
18 I am pressured to work long hours < 2 >= 2 & < 4 >= 4 & < 4.95 >= 4.95 Approx. 
20 I have to work very fast < 2 >= 2 & < 3 >= 3 & < 4 >= 4 Approx. 
22 I have unrealistic time pressures < 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95 Approx. 
 Control      
2 I can decide when to take a break < 3 >= 3 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 

10 I have a say in my own work speed < 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95  
15 I have a choice in deciding how I do my work < 2 >= 2 & < 3 >= 4 & < 4.95 >= 4.95  
19 I have a choice in deciding what I do at work < 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95  
25 I have some say over the way I work < 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 
30 My working time can be flexible < 2 >= 2 & < 4 >= 4 & < 4.95 >= 4.95  
 Managers’ Support      
8 I am given supportive feedback on the work I do < 2 >= 2 & < 3 >= 3 & < 4.95 >= 4.95  

23 I can rely on my line manager to help me out with a 
work problem 

< 2 >= 2 & < 4 >= 4 & < 4.95 >= 4.95  

29 I can talk to my line manager about something that 
has upset or annoyed me about work 

< 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95  

33 I am supported through emotionally demanding 
work 

< 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95  

35 My line manager encourages me at work < 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95  
 Peer Support      
7 If work gets difficult, my colleagues will help me < 3 >= 3 & < 4 >= 4 & < 4.95 >= 4.95  

24 I get help and support I need from colleagues < 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 
27 I receive the respect at work I deserve from my 

colleagues 
< 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 

31 My colleagues are willing to listen to my work-
related problems 

< 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 

 Relationships      
5 I am subject to personal harassment in the form of 

unkind words or behaviour 
< 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 

14 There is friction or anger between colleagues < 3 >= 3 & < 4 None >= 4 Not possible to set cut-offs for the 50th-80th percentile range 
21 I am subject to bullying at work < 5 None None 5 Anything < 5 falls below 20th percentile  
34 Relationships at work are strained < 2.09 >= 2.09 & < 4 >= 4 & < 4.91 >= 4.91  
 Role      
1 I am clear what is expected of me at work < 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 
4 I know how to go about getting my job done < 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 

11 I am clear what my duties and responsibilities are < 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 
13 I am clear about the goals and objectives for my 

department 
< 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 

17 I understand how my work fits into the overall aim of 
the organisation 

< 4 >= 4 & < 4.95 None >= 4.95 Not possible to set cut-offs for the 50th-80th percentile range 

 Change      
26 I have sufficient opportunities to question managers 

about change at work 
< 2 >= 2 & < 4 >= 4 & < 4.95 >= 4.95  

28 Staff are always consulted about change at work < 2 >= 2 & < 4 >= 4 & < 4.95 >= 4.95  
32 When changes are made at work, I am clear how 

they will work out in practice 
< 2 >= 2 & < 4 >= 4 & < 4.95 >= 4.95  
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